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Welcome! 
Microsoft Word is a word processing application you can use to create all sorts of 

documents from letters to posters and flyers.  It is full of tools to save you time and hassle 

and make calculating with figures quick and easy. 

This IT Training course will show you how to: 

• Manage Word Documents 

• Produce Documents 

• Use Formatting 

• Use Spell Checking, Grammar Checking and the Thesaurus 

• Using Find and Replace 

• Create simple tables 

If you have been using Word for a while, you may already know how to use some of the 

features covered in this guide, but if you were taught using previous versions of Word we 

hope that these notes here will help you upgrade your skills and knowledge and take 

advantage of the new features on offer. 

To help you, you will find the following symbols used throughout this guide: 

This symbol will indicate information that you need to be aware of, tips and tricks and occasionally, things to watch out for to 

avoid problems. 

This symbol will be shown when you need to take care and pay attention to what you are doing to avoid creating problems 

for yourself. 

 

 

Best wishes 

IT Training Team (Cheshire) 

IT Services, Midlands and Lancashire CSU 

 

Contact 

Email: csu.ittraining@nhs.net 

Telephone:  01606 544468 
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Launching Word O365 
To launch Word you need to select the Word logo from your Desktop or Start Menu.  The 

Word Window will appear: 

 

Title Bar: Shows the name of the current window and the currently displayed 

file (Document1). 

Quick access  

toolbar: The Word Quick access toolbar (QAT). 

Ruler: The horizontal and vertical rulers work in Centimetres by default 

Document: Word files are known as Documents 

Status Bar: The Status Bar provides a variety of status information about the 

current document. 

  



 

 

Entering Text 
If you start typing text it will always appear to the left of the Insertion Point.  

Word Wrap 

When you type text as your typing reaches the end of the line the text is automatically move 

or “wrapped” on to the next line. 

Paragraph Marks 

A paragraph mark is inserted when you press Enter.  Paragraph Marks are non-printing 

characters that are used to help you when you are editing.  To display the paragraph 

marks, click .  The paragraph marks at the end of each paragraph will now be shown as 

will the spaces between words which are marked as a small dot and any tabs that you have 

pressed will be shown as a small arrowhead. 

In the example the dots marking the spaces between the 

words are clearly shown.  The Tab mark arrows and 

paragraph marks can also be seen. 

To remove the paragraph and other marks from view click . 

Status Bar Indicators 

The Status Bar across the bottom of the screen displays information about your document 

and certain mode indicators: 

Document Details 

This details the page, total number of pages and the number of 

words.  Double click on the Page number to access the Find and Replace feature.  Use 

this to move quickly to a particular page, section or other position in the document.  

Alternatively click on the Find or Replace icons on the Home ribbon to search for text 

within the document.  (For further assistance with Find and Replace please see later in this 

Guide.) 

  



 

 

Mode Indicators 

The status bar displays various mode indicators; one 

indicator that is displayed by default is Spelling and Grammar 

checking.  Other indicators can be activated as you require 

them by right clicking on the status bar and selecting the 

option from the menu. 

Mode Purpose 

 

Spell and Grammar Checking.  A cross appears to display that 

there are words that have not been recognised.  A small pencil 

on the book signifies that text is being typed into the document. 

 

Macros 

Show/Hide Rulers 

If you want to see or temporarily hide the rulers on the screen click the 

View tab and select Ruler from the Show group.  

Document Views 

There are five different ways in which you can view a document on screen.  To change the 

view of your document, click the View tab or the following icons just above the Status bar 

in the bottom right hand corner of the screen.  The default view is Print Layout.   

Icon View Purpose 

 

Print Layout Displays the page exactly as it will appear when it is printed 

 

Read Mode If you are opening a document to read it, use reading layout 

view. Reading layout view hides all toolbars except for the 

Reading Layout and Reviewing toolbars.  

 

Web Layout Word can be used to create Web pages.  It will display the 

document exactly as it will look in a Web browser 

 
Outline Displays the document text only and provides the ability to 

expand and collapse the document by its heading hierarchy.   

 
Draft Displays the document without true print layout being 

displayed. This is useful for pure text editing. 



 

 

Controlling Document display size 

To increase or decrease the display size of the document while you are working on it, use 

the Zoom Control slider in the bottom right corner of the screen.  Click and drag the marker 

on the slider or click the + and – symbols. 

 

You can also click on the percentage and adjust the settings.  Click  to confirm. 

 

  



 

 

Editing Text 
To edit the text, use the methods listed below: 

Action Method 

Insert Text Position the insertion point where you 

want the text to appear and type! 

Replace 

existing text 

Select the text you want to replace and 

start typing.  The selected text will be 

replaced with the text that you type. 

Delete Text To delete text to the left of the insertion 

point press BACKSPACE. 

To delete text to the right of the insertion 

point press DELETE. 

Delete the word 

to the left 

To delete the word to the left of the 

insertion point press CTRL BACKSPACE 

Delete the word 

to the right 

To delete the word to the right of the 

insertion point press CTRL DELETE 

Undo and Redo 

There are two buttons on the Quick Access Toolbar that are very useful when editing a 

document.  Undo  and Redo  provide the ability to unpick the actions you have 

taken in a document and redo them if you have unpicked them too far!   

Insertion Point Movement 

Move the insertion point quickly to where you want to type or edit your document can be 

very useful.  The following table summarises the shortcuts available: 

Action Key combination 

One character to the left  LEFT ARROW  

One character to the right  RIGHT ARROW  

One word to the left  CTRL+LEFT ARROW  

One word to the right  CTRL+RIGHT ARROW  

One paragraph up  CTRL+UP ARROW  

One paragraph down  CTRL+DOWN ARROW  



 

 

Action Key combination 

One cell to the left (in a table)  SHIFT+TAB  

One cell to the right (in a 

table)  

TAB  

Up one line  UP ARROW  

Down one line  DOWN ARROW  

To the end of a line  END  

To the beginning of a line  HOME  

To the top of the window  ALT+CTRL+PAGE UP  

To the end of the window  ALT+CTRL+PAGE 

DOWN  

Up one screen (scrolling)  PAGE UP  

Down one screen (scrolling)  PAGE DOWN  

To the top of the next page  CTRL+PAGE DOWN  

To the top of the previous 

page  

CTRL+PAGE UP  

To the end of a document  CTRL+END  

To the beginning of a 

document  

CTRL+HOME  

To a previous revision  SHIFT+F5  

After opening a document, to 

the location it was in when 

the document was last closed  

SHIFT+F5  

 

  



 

 

Selection Techniques 

Selecting text is a vital skill as you will need to do this to apply formatting, perform editing 

etc.  Try the following methods: 

Action Method 

Select any piece of text  Drag across the text with the I 

beam, releasing the mouse 

only when the required text is 

selected 

Select several pieces of text 

that are not next to each other 

Drag across the first piece of 

text with the I beam to select it.  

Hold down CTRL and drag over 

the second piece of text.  

Repeat as required. 

Character to the right of the 

insertion point 

SHIFT+RIGHT+ARROW 

Character to the left of the 

insertion point 

SHIFT+LEFT+ARROW 

From the Insertion Point to the 

end of the current word 

CTRL+SHIFT+RIGHT ARROW 

From the Insertion Point to the 

beginning of the current word 

CTRL+SHIFT+LEFT ARROW 

Line above SHIFT+UP ARROW 

Line below SHIFT+DOWN ARROW 

Entire Document CTRL A 

A word Double click with the I beam 

hovering over the word. 

A sentence CTRL and click anywhere in 

the sentence 

A paragraph Triple click anywhere in the 

paragraph 

Vertical Block (not in tables) Hold down ALT and drag the 

mouse over  

 

  



 

 

Selection using the left-hand margin 

The left-hand margin in any Word document can be used to quickly select text, 

paragraph and the entire document quickly. When you put your mouse over the 

left-hand margin it changes from the I Beam into a mouse pointer pointing at the 

text.  Once you have found this mouse pointer, use it to point and select as follows:  

Action Method 

Select a line  Point at the line and click 

Select a paragraph Point at the paragraph and double 

click 

Select multiple 

paragraphs 

Point at the top of the first 

paragraph and drag down until all 

the paragraphs required are 

selected. 

Select entire 

document 

Triple click in the left margin. 

 
  



 

 

Managing Word Files 

Starting a New document 

To start a new document, click  from the Quick Access 

toolbar.  Alternatively click the File tab, select New and double 

click Blank Document.  

Saving Documents 

Saving a new document 

To save the current document for the first time click  or choose File, Save As and click 

Browse.  A dialog box will display showing your Documents folder.  Enter a name for the 

file in the File Name: box and click .  The Title Bar for the window will change to 

display the name given to the file. 

Saving an existing document 

If the document you want to save already 

has a name and all you want to do is update 

the file with the changes, click  or 

choose File, Save. 

Saving an existing document under a 

new name 

To save an existing document under a new 

name or into a different location choose 

File, Save As and click Browse.  Select the 

location for this new version of the file to be 

stored and enter the new name in the File 

Name box.  Click . 

Opening and Closing documents 

Closing 

To close a document, click the  in the right-hand top 

corner of the window.   

Alternatively choose File, Close.  If you have made any 

changes since you last saved the file, Word will prompt 

you to Save the changes.   

Click Save to update the file with the latest changes or click Don’t Save to discard the 

changes you have made. 



 

 

If you click Cancel, you will cancel the Close command.  

Opening 

To open a document file that you have saved, click  or choose File, Open and click 

Browse.  The Open dialog box will display showing your Documents Folder.  Select the 

file that you want to open and click Open. 

Changing the display in the Open Dialog box 

To change the display of the files in the Open dialog box click .  Choose from the 

available Views: 

View Name Display 

Extra Large 

Icons 

Extra-large icons for each folder and file 

are displayed 

Large Icons Large icons for each folder and file are 

displayed 

Medium 

icons 

Medium icons for each folder and file are 

displayed 

Small Icons Small icons for each folder and file are 

displayed 

List Very small icons for each folder and file 

are displayed 

Details  The details of the file size, type and date 

modified are shown 

Tiles Large icons for each folder and file are 

displayed 

Content More details about each individual files 

can be viewed for example the size. 

Deleting and Renaming Files 

Deleting Files in the Open dialog box 

Select the file you want to delete and press Delete on 

the keyboard.  You will be prompted to confirm that 

you want to delete the file. Click Yes.  

If you are deleting from a network drive the file will be 

deleted permanently. 



 

 

Renaming a file 

Select the file you want to rename and click Organize and select Rename.  The name 

against the file will now appear highlighted. E.g.:    Edit the name as 

required and press Enter when done.  

Working with Folders 

Managing Folders  

To create a new folder, click .  Enter a name for your new folder and press Enter 

on the keyboard.   

Double click to open the folder.  To return to the top of your folder hierarchy, click the  

back button in the top left corner of the dialog box or click Documents from the left-hand 

side of the dialog box.   

Moving Files 

To move a file from one folder into another, point at the file and drag it over the file you 

want to move it to so that the folder name appears highlighted in blue.  Release the mouse. 

Working with Recent Files and Folders 

Click File in the top left corner of the screen and click Open. 

 

A list of your recent Documents and Folders will be displayed.  Click the document or 

folder to open or view the content. 

Hover over the name and click the push pin to the right of the document or folder. 

 



 

 

The push pin will remain on the right side  and the document or folder will be added 

alphabetically in a separate list at the top of the page. 

The documents and folders that have a blue push pin will remain at the top of the page in 

the recent area.  The items underneath this area will recycle round each time you open a 

new document or place. 

 

Document Recovery 

Your document will be saved every 10 minutes.  If the document has already been saved to 

a location with a name, the versions will be displayed in the Info area.  Click File and Info. 

  

If the document has not been saved and you close the document a message will be 

displayed: 

 

An additional message is included in the dialog box to confirm a recent copy will be 

available if you do not save the document.  If you click Don’t Save, click File, Open, 

Recent and select at the bottom of the screen. 

  



 

 

From the dialog box select the document and click Open. 

 

 

 

 

 

 

 

 

 

 

The document will be opened and a message will be displayed at the top of the screen: 

 

Click Save As to select a location to save the document and provide a file name. 

  



 

 

Formatting Text 

Changing the Font 

Select the text that you wish to change.  From the Home tab, click the 

Font drop down and click the required font. 

If you hover over the Font you can view the changes first before clicking to apply the 

change. 

Changing the Font size 

To change the size of the font, select the text that you want to change.  From the 

formatting toolbar click the Size drop down and select the size required. 

You can also use the Grow and Shrink buttons to adjust the Font Size  

Alternatively select the text and try the following: 

Size alteration Key 

combination 

Next size up CTRL+SHIFT+> 

Next size down CTRL+SHIFT+< 

Increase by 1 

point 

CTRL+] 

Decrease by 1 

point 

CTRL+[ 

Adding Font Enhancements 

Bold, italic and underline can easily be added to text.  Select the text that you want to 

enhance and click  for bold,  for italics and  for underlining from the Home tab.  

Alternatively select the text and press CTRL B for bold, CTRL I for Italic or CTRL U for 

underlining. 

Adding Colour to text 

Select the text you want to colour and click  drop down from the 

Home tab.  The colour palette will display.  Hover over the colour to 

view the changes, click the colour to apply. 

Enhancing Underlining 

Click the drop-down arrow to the side of the Underline button.  Hover 

over the lines or colours to view the changes and click to apply. 



 

 

Using Format Font 

Select the text, navigate to the Home tab and click the Dialog Box Launcher button in the 

Font group.  Select the Font Tab.  From within this dialog box you can change the Font, 

size colour and add the enhancements of bold, italic and underline as previously discussed 

above. 

 

Font effects 

The Format Font dialog box offers a range of font effects.  Select as required: 

Effect Name Display 

Strike through IT Training Team 

Double strike 

through 

IT Training Team 

Superscript IT Training Team    

Subscript IT Training Team 

Small caps IT TRAINING TEAM 

All Caps IT TRAINING TEAM 

Hidden Text selected and given the effect of Hidden will not be shown 

unless the Paragraph Marks are displayed.  When displayed 

hidden text appears underlined with small dots.  E.g. .  

Click  to turn the display hidden text on and off. 



 

 

Text Effects 

The Text Effects on the Home ribbon offers effects that you 

can add to selected text.   

Select the text and click .  Hover over the options to view 

the changes and click to apply. 

 

 Inserting Symbols 

To insert symbols into your text that do not appear on the 

keyboard, position the insertion point where you want the 

symbol to appear and navigate to the Insert tab and click .  

From the options click a Symbol to insert.  Click More Symbols to 

view more symbols. 

Select a Font from the drop-down menu, 

popular fonts are Wingdings and Webdings. 

Click the Symbol and click Insert.  Click 

Cancel to close the dialog box. 

If you select the Special Characters tab, a 

range of specialist characters appear along 

with their keyboard shortcuts.  For example, 

pressing ALT+CTRL+T will produce the 

Trademark symbol ™. 

 

Clear Formatting 

Select the text and click  in the Font group on the Home ribbon.  This will clear any 

formatting that has been applied.  You can also click  from the Styles group.



 

 

Formatting Paragraphs  
Paragraph formatting options control a complete paragraph: 

Horizontal Alignment 

To change the horizontal of text, select the paragraph and click one of the following on the 

Home ribbon: 

  Centre  Right Align  Justified  Left 

The paragraph will align between the left and right margins.  The following keyboard 

shortcuts are also available: 

Alignment Key 

combination 

Left CTRL+L 

Right CTRL+R 

Centre CTRL+E 

Justified CTRL+J 

Line Spacing 

Select the paragraph(s) and click the drop down of the line spacing button .  Select 

the line spacing required from single, one and a half, double, two and a half, triple or click 

Line Spacing Options for additional options from the Format Paragraph dialog box.  The 

following keyboard shortcuts are also available: 

Line Spacing 
Key 

combination 

Single CTRL+1 

1.5 CTRL+5 

Double CTRL+2 

Paragraph Indents 

To indent a paragraph(s) from the left-hand margin, select the paragraph and click   

from the Home ribbon.  The paragraph will be indented and if the Rulers are displayed the 

left-hand margin marker will have moved to indicate the indent set:    

Click as many times as required to indent the preferred distance.  If you need to decrease 

the indent from the left margin, click  as required. 



 

 

To indent the right-hand margin, select the paragraphs you want to change the right 

margin for and point at the Right Indent marker on the Ruler.  Drag the marker to the 

required indent.   

Using Format Paragraph 

You can use the Format Paragraph dialog box instead of the buttons on the Home ribbon.   

Select the paragraph(s) you want to format, navigate to 

the Home tab and click the Dialog Box Launcher button 

in the Paragraph group.   

Adjust the settings to alter the alignment, indents and line spacing as required. Click 

. 

 

 

 

 

 

 

 
  



 

 

Adding Bullets 
Bullets can be easily added to paragraphs.  Select the paragraph(s) 

and click .  The bullets will now appear. 

To extend the list, press Enter at the end of the last line of bullets and a 

new bullet will appear.  Repeat as required.  To turn the bullets off, press 

Enter twice, or click . 

 

Formatting Bullets 

To change the formatting of bullets, select the paragraphs 

containing the bullets you want to change and click the 

arrow at the side of the Bullets button.    

Click on an alternative style or click Define New Bullet to 

customise your own bullet. 

 

 

In the Define New Bullet dialog box click Symbol to access the Symbol library. 

 

Choose a Symbol and click . 

Choose Font to alter the font, size and colour of the bullet character. 

Choose Picture to select a bullet character from the clipart library. 

Click when complete. 

Adding Numbers 

Click .  The number 1. will appear; type the first paragraph for your numbered list.  

When you press Enter the next number will appear.  Repeat as required.  E.g.: 

1. Apples 
2. Pears 
3. Bananas   

To turn off automatic Numbering, press Enter twice at the end of the list or click . 



 

 

Formatting Automatic Numbered Lists 

To alter the format of an automatic Numbered list, select the 

paragraphs that have been numbered and click the arrow at 

the side of the Numbering button.   Click on an alternative 

style or click Define New Number Bullet to customise your 

own bullet. 

Select the numbering style required.  Adjust the settings as 

required. 

Click the Font button to alter the font, size and colour.  Click 

OK when complete.  E.g. 

One. Apples 
Two. Pears 
Three. Bananas   

 

 

 

 

 

 

 

 

Turning Off Automatic Numbering 

Many users find automatic numbering difficult to work 

with and prefer to enter their own numbers as they type.  

If you want to turn automatic numbering off, choose File, 

Options, Proofing and click  on the 

right. 

Click the Autoformat As You Type tab.  Un-tick the 

option Automatic numbered lists. 

Click  to confirm. 



 

 

Text Borders 

Borders can be added to paragraphs easily. Select the paragraph 

that you want to add borders to and click the drop down on the 

borders button .  Select the border required.  Some of the 

options are only available for tables.  The options available for text 

shown here: 

 

 

 

 

The option Horizontal line will simply insert a horizontal line at the 

position of the insertion point. E.g. 

 

The borders will be applied based on the left and right-hand margins of the text and above 

and below the selected text/paragraph. 

Enhancing borders 

Select the text that you want to add borders to or enhance the existing borders of and click 

the arrow at the side of the Borders button, click  at the bottom 

of the menu. 

Select a Setting from the left. 

Select a Style, Colour and Width.   

The preview will display the changes. 

Click the buttons around the outside to turn the lines on or off. 

Check the Apply to option is set to Paragraph and click  to confirm the changes. 

  



 

 

Shading Paragraphs 

Background shading can be added to a paragraph.  Select the 

paragraph and click the arrow at the side of the Shading button on 

the Home ribbon.  

 

Hover over the colour to view the changes and click to apply. 

The IT Training Team 

The shading will be applied based on the left and right-hand 

margins of the selected text/paragraph. 



 

 

Spell checking 
If a word is typed into a document and Word cannot find it in the Office dictionary, it will be 

underlined in red.  e.g.    

Word will also underline in red any repetition of a word e.g.: 

Spell checking a single word 

To correct the word, place the I Beam over the word and right click.  The quick menu will 

appear with suggested “correct” spellings listed at the top of the menu.  If the correct 

spelling is shown, click it with the left mouse button. 

 

Add to Dictionary 

Choose this to add the “incorrect” word to your dictionary.  This is useful for proper nouns, 

such as people’s names, places, products and company names.   

Please make sure the word is correctly spelled before you click Add to Dictionary! 

Ignore All 

The Ignore All option if chosen will ignore the spelling that Word considers to be incorrect 

throughout the current document. 

Spell checking a document 

To spell check the current document, click  on the 

Quick Access Toolbar, or press F7.  The first mistake will 

be highlighted and the Spelling navigation pane on the 

right of the screen will be displayed: 

If the correct spelling for the word is shown in the 

Suggestions box, click the correct spelling to make the 

change. 

Ignore Once 

Choose this option to ignore the word that Word suggests 

is miss-spelled. 



 

 

Ignore All 

The Ignore All option if chosen will ignore the spelling that Word considers to be incorrect 

throughout the current document. 

Word will ignore the spelling of this word in this document and any other documents that are checked during the current 

Word session. 

Add to Dictionary 

Choose this to add the “incorrect” word to your dictionary.  This is useful for proper nouns, 

such as people’s names, places, products and company names.   

Please make sure the word is correctly spelled before you click Add to Dictionary! 

Delete Repeated Word 

This option will appear if you have typed in the same word twice.  Select Delete Repeated 

Word to delete the second occurrence of the word. 

   



 

 

Grammar Checking 
Grammar is checked automatically at the same time as spell checking.  Any mistakes in 

Grammar are underlined in blue.  

Correcting a single word 

Place the I beam over the word that is marked as a 

grammatical error and right click.  Select the suggested 

alternative or choose one of the options.  

Ignore Once 

Choose this option to ignore the word that Word 

suggests is grammatically incorrect. 

Don’t check for this issue 

Select this option to stop checking for this issue. 

Options for “Grammar” 

Select this option to open the Grammar navigation pane. 

Correcting a document 

Click .  Word will commence spell checking the document, but if any errors in 

grammar are detected they will appear in the dialog box. 

The Grammar error is displayed at the top with 

suggestions.  Click one of the suggestions to apply 

the change. 

 

Ignore Once 

Choose this option to ignore the word that Word 

suggests is grammatically incorrect. 

Don’t check for this issue 

This option will leave all occurrences of the 

highlighted grammatical error unchanged throughout 

the document.   

Options for “Grammar” 

To change the Grammar settings. 



 

 

Using the Thesaurus 
To make sure that you are using words that best 

convey your meaning in any given context, you can 

call up the built in Thesaurus to look up alternative 

words or synonyms for a selected word.   

Place the I beam over the word that you want to look 

up and right click.  Choose Synonyms.  A list of 

alternative words that have the same or very similar 

meanings will be displayed.  Click the word required 

to replace your original word. 

Full Thesaurus 

The full Thesaurus window can be accessed by selecting the Thesaurus option 

after a right click, or by selecting the word to be checked and choosing Review 

ribbon, Thesaurus or by pressing SHIFT+F7. 

The Task Pane will appear with the Research view in use.  The meaning of the words will 

be shown in bold with the type of word (e.g. Verb, noun, pronoun etc.) shown abbreviated in 

brackets after it.   

Insert/Substitute 

Point at the word/phrase that you think you want to substitute for your 

original word and choose Insert from the displayed drop-down list.    

Copy 

Choose Copy, to add the selected word/phrase to the Clipboard so 

that you can paste it in later. 

Lookup 

Double click the word/phrase to look up that word or phrase in the 

Thesaurus.  In the example we looked up “training”.  To return to 

the original list of words that were found click < .  In some lists of 

words found the Antonym (opposite of) the word will also be 

displayed. 

  



 

 

Find and Replace 
The Find and Replace facility in Word provides the ability to search for a word or phrase 

within the current document and to selectively decide if the found word is to be replaced 

with an alternative.   

Find 

To ask Word to find a word or phrase, select the Home ribbon and click    The 

Task pane will display on the left of the screen: 

Type the word(s) in the search box and press Enter or click the 

Magnifying Glass. 

The number of matches will be displayed and the first instance 

will be highlighted in the document.  Click each match to view 

the text in the document. 

 

Click Headings or Pages in the Task Pane to browse different 

parts of the documents. 

Advanced Find 

From the Home ribbon click the arrow to the side of the Find icon and click 

Advanced Find or click CTRL+F.  The Find and Replace dialog box will 

be displayed: 

 

Type in the word or phrase that you want to find and click the Find Next button.   

The word or phrase will be located (if it exists) and selected.  Click Cancel to remove the 

Find and Replace dialog box from the screen.  The found text will remain selected so that 

you can edit it.  To continue with your Find command, choose Home, Advanced Find 

again and click Find Next.  Repeat as required. 

  



 

 

Replace 

To ask Word to find a word or phrase and replace it with another word or phrase, choose 

Home ribbon and click  or press CTRL+H.  

Enter the word/phrase that you want to find 

and enter the text that you want to replace it 

with.  Click Find Next.   

The first occurrence will be highlighted, click 

Replace to replace it and the next 

occurrence will be highlighted.  If you do not 

want to replace one of the found 

occurrences, simply click Find Next rather than Replace. 

Replace All 

Replace all will replace all occurrences of the Find text with the Replace text very quickly.   

Be careful what you search for when using Replace All.  If you search for a word that could be found in other words, you 

may find that Replace All will replace text that you did not expect!  For example, if your find text was “act” and your 

replace text was “perform”, using Replace All would alter words such as “character” to “charperformer”.  To solve this problem, use Find 

whole words only (see below). 

Search Options 

The search options can be found under the  button.   

Match Case 

Tick this box to instruct Word to only 

find occurrences of the Find text that 

have the same capitalisation. 

Find whole words only 

Tick this box to instruct Word to only 

find occurrences of the find text as a 

whole word rather than a string of 

characters within a word. 

Use Wildcards 

You can specify wildcards in the 

search text.  Wildcards are 

characters that Word can substitute 

for any character or string of 

characters.  

  



 

 

The two most commonly used wildcards are: 

? Used to represent any single character. 

* Used to represent any number of characters 

Use Word Help and search for Wildcards to find additional wildcards and their definitions if you need them. 

 

Sounds Like 

This option will find occurrences of the Find text that sound the same but are spelled 

differently, e.g. brake and break, there and their etc.   

Find all word forms 

This option will find occurrences of the find text in any form, e.g. train, training, trained, 

trainer.   

Match Prefix 

This is a good choice when you’ve got a word on the tip of your tongue and can only 

remember how it starts. Turn on this checkbox to find matches to the beginnings of words—

for example, if you want a search for “pe” to return “petunia,” “pert,” and “pernicious,” but 

not “ape” or “type.” 

Match Suffix 

This matches the ends of words. So you would turn it on if you want to find all words that 

end in “ing,” such as “standing” and “running,” but don’t want results like “ingot” or “twinge.” 

Ignore Punctuation Characters 

Turn this on when you want Word to ignore hyphens, apostrophes, and other punctuation 

marks when searching. For example, searching for “backup” would include “back-up” in the 

results. 

Ignore White-Space Characters 

When turned on, this checkbox tells Word to ignore spaces, tabs, paragraph marks, and 

other non-printing characters in its search, so a search for “rundown” would include “run 

down” in the results. 

Format 

Use the Format button to specify certain types of formatting that you want 

to search for.  For example, to find all occurrences of text that has been 

enhanced with italics, select the Format option and choose Font.  Select 

Italics and click on OK.  Click Find and the first item of italicised text will 

be located.  Repeat the Find command as often as required.  



 

 

Special 

The Special option offers different non-printing characters and other elements that make up 

a document that you can search for.  Click in either the Find or Replace box.  If you select 

one of the items, a special code is inserted in the Find or Replace box.  Search as required.   



 

 

Page Setup 
The Page Setup controls manage your paper size, orientation, margins, page alignment 

and much more.   

Paper Size 

In the UK the paper size A4 is normally used for documents and letters.  

To check or change your paper size to A4, choose Layout tab and click 

the Size button in the Page Setup group. 

 

Page Orientation 

To alter the orientation of the page between landscape and portrait, choose 

Layout tab and click the Orientation button.  Select the orientation 

required.  

 

Page Margins 

To alter the margins of the document, 

choose Layout tab and click the 

Margins button.   

Select one of the margin styles or click 

Custom Margins at the bottom of the 

menu to set your own margin settings. 

 

 

 

 

 

If you set your margins so that they are too narrow for the printer to be able to print the 

page correctly, the message shown here will appear.  Click Fix to have Word set the 

margin that was too narrow to the minimum acceptable. 

 

 

 

 

  



 

 

Vertical Alignment 

The default vertical alignment for a document is Top.  Change it to one of the other options 

to create different effects.  Choose Layout tab and click the dialog box launcher button.   

 

The Page Setup dialog box will be displayed.  

Click the Layout tab and select the Vertical 

Alignment drop down and select as required. 

Click  to confirm the changes. 

 

 

 

 

 

 

 

 

The examples below show what happens to two lines of text when the vertical alignment is 

changed: 

Top:  Centre:  Justified:   Bottom:  

  



 

 

Business Letter Layout 
Business letters are typically laid out in a style called Fully Blocked.  In this style, no 

commas are used after the salutation or complimentary close, and paragraphs start flush 

with the left margin: 

 



 

 

Printing 

Quick Print 

To print one copy of the current document, click  from the Quick Access toolbar. 

Print Preview and Print Settings 

Choose File, Print to display the Print Preview and Print Settings screen. 

 

Print Range 

The default print range is Print All Pages.  Select 

Print Current Page from the options to print only the 

page that is displayed on the document preview.  

If you have selected some text, the Print Selection 

option will be available.  Select Selection to print only 

the text that is currently selected. 

Pages is used to specify a series of pages within the 

current document.  Separate page ranges with 

commas.  

  



 

 

Print Copies 

The default number of copies printed is one.  Alter the number 

of copies as required.  

Collated 

The collate option can be used when printing copies to 

print the whole document the number of times specified 

or to print each page the number of times specified.  

Select Collected or un-collated from the drop-down 

options as required. 

Orientation 

Adjust the orientation between Portrait and Landscape.  

 

Paper Size 

Adjust the paper size from the options.  

Margins 

Select one of the margin styles or click Custom Margins to 

adjust the margins manually.  

Scale To Fit 

Use Scale To Fit to reduce the size of the print so that one 

sheet of A4 paper contains between 2 and 16 pages. The 

pages are reduced to fit the number of sheets specified. 

Zoom Control 

To increase or decrease the display size of the document 

while you are working on it, use the Zoom Control slider 

in the bottom right corner of the screen.  Click and drag 

the marker on the slider or click the + and – symbols. 

 

You can also click on the percentage and adjust the 

settings.  Click  to confirm. 



 

 

Printing Envelopes 

To print an envelope directly from a letter that you have 

typed, select the address in the document and choose 

Mailings tab and click the Envelopes button.  

If the address in the Delivery Address box is incorrect, 

adjust as required.  If you want to print a Return Address 

on your envelope, type it in or select from the Global 

Address List by clicking . 

Envelope size 

A standard A4 folder business envelope is size 

DL110 x 220mm.  To check that you have the right 

envelope size or to change the envelope size click 

the Options button and select as required. 

Notice the Feed diagram showing you where 

to place the envelope in the manual feed tray of your printer to make sure that you 

printer can handle it successfully.  

 

Print vs Add to Document 

Click the Print button to print the Envelope immediately.  You may find that the printer will 

wait for you to insert the envelope in the manual feed tray before it attempts to print. 

Click Add to Document to add the envelope to the document so that when you print the 

document the envelope is automatically printed with it.  However, you will find that the 

printer will probably wait for you to load the envelope into the manual feed tray, so it will not 

be printed without any intervention from you! 

Printing Labels 

If you want to print a label for an address in your current 

document, select the address and choose Mailings tab and 

click the Labels button.  

Single Label 

If you only require a single label, select Single Label and 

specify the row and column of the label on your label sheet 

that you want to use.  (The idea is that you can put the 

same label sheet through the printer repeatedly until all the 

labels have been used up.) 

Full page of the same label 

Choose this option to print a full sheet containing the address specified in the Address box.  

This can be useful for addresses that you use regularly. 



 

 

Label Size Options 

To specify the label size that you are using, click the Options button.  Most label stationary 

manufacturers use the Avery A4 and A5 size codes.  Select this as the Label Product and 

then find the label size Product Code from the label stationary you are using.    Click OK.  

 

 

 

 

New Document vs Print 

Click the New Document button to have the labels appear in a table ready for printing.  

Alternatively click Print to print the labels but don’t forget to put them in the printer first!  

Putting the labels into a new document means that you can save it and then print it again as 

and when you need it.   

  



 

 

Headers and Footers 
Click the Insert ribbon and click Header or Footer.  

From the drop-down menu select the most suitable Header or Footer 

style. 

 

The document will change to view the header at the top of the page: 

 

Click Type Here to overwrite with your own text.  Press the Tab key on the keyboard to 

move to the centre or right side of the header.  The same can be repeated for the footer. 

Alternatively, double click in the header or footer area on the page.  This will display the 

Header & Footer Tools ribbon. 

 

Use the ribbon to insert items into your Header or Footer area or type text. 

Scroll up or down the screen and click into the relevant area.  Press the Tab key to move to 

within the header or footer area, to the centre or right side. 

Click Close Header and Footer on the ribbon when you have finished.  



 

 

Tables 
A table is a grid of columns and rows that can be easily inserted into a document to hold 

text and numbers in a neat and organised manner. 

Creating a Table 

Navigate to the Insert ribbon and click .  A grid will appear.  Drag 

the mouse over the grid squares to define the table you require and the 

table will be displayed, click to insert the table.   

The table will appear in the document as the position your insertion point 

was, with the insertion point in the first grid square (cell).  You do not 

need to specify all the rows, but it is advisable to specify the number of 

columns that you require. 

Alternatively, choose  and click from the 

options.  Specify the number of columns and rows required and 

alter the AutoFit behaviour and Autoformat as required: 

Fixed column width 

The columns will all have a set width. 

This is fixed width.  As 

you type the text 

wraps around with the 

cell. 

 

  

AutoFit to contents 

The width of the columns will alter automatically to fit the text that is typed into them. 

 

This is 

autofit 

As you 

type the 

Column expands to accommodate the text you are 

typing.  When the right margin is reached the text will 

begin to wrap 

 

Autofit to window 

This is usually used when creating web pages and works in a very similar way to Fixed 

column width in a normal document. 

Table Tools Ribbon 



 

 

When you click the table the Table Tools ribbon will be displayed at the top of the screen. 

There are 2 tabs, Design and Layout.  

 

 

Typing in a Table 

Click into the cell of the table that you want to type into and start typing.  Press Tab to move 

to the next cell, even if it is on the next row. 

Selecting Rows, columns and cells 

Cells 

Point to the left of the cell until the selection arrow appears.  Click to 

select the cell.    

Rows 

Point to the left of the cell at the beginning of the row until the 

selection arrow appears.  Click to select the cell and drag over 

other cells with this symbol to select the row. (Alternatively try 

using the selection point for a line in the left-hand margin of the document.) 

Columns 

To select a column, place the I beam on the top line of the column 

and the selection arrow will appear.  Click the mouse.  To select 

multiple columns, hold down the mouse and drag over the columns 

required. 

Table 

To select the whole table click the  symbol that appears when you point at the table. 

Adding a New Row 

At the end of the table 

To add a new row to the table, click in the last cell of the table and press Tab.  The table will 

extend by one row. 



 

 

Inserting Rows 

To insert a row, select a row and click  or  from the Layout ribbon. 

Adding a new column 

Inserting Columns 

To insert a column, select a column and click  or  from the Layout ribbon. 

Deleting Rows and Columns 

Deleting Rows 

To delete a row, select a row and click  from the Layout ribbon and 

select Delete Rows. 

Deleting Columns 

To insert a column, select a column and click from the Layout ribbon 

and click Delete Columns. 

Changing Column width 

To alter the column width, point the right-hand column border to display the resize tool .  

Drag the border to the required width.  Alternatively, double click to have Word autofit the 

width of the column to the widest entry in that column. 

Changing Row height 

To alter the row height, point to the bottom border of the row to display the resize tool  

.  Drag the border to the required depth. 

Distribute Rows and Columns evenly 

To distribute the space between rows or columns in a table evenly, select the table and 

click  to distribute rows evenly or  to distribute columns 

evenly as required.  These buttons can be found on the Layout ribbon. 



 

 

Merge Cells 

To merge cells together to form large cells, select the cells and click from the Layout 

ribbon.   

 

Before:  

 

After: 

Aligning text in cells 

Horizontally and Vertically 

To align text in cells, select the cells and use the alignment tools on the 

Layout ribbon.  

Add Borders 

To add borders to a table, select the table or the part of the table that 

you want to add border to and click the arrow at the side of the 

Borders icon.  Select the borders required.   

Alternatively, select the table and right click and select Borders and 

Shading from the menu options.  Click the Borders tab and adjust the 

settings as required.  Check the Preview area and the Apply to box 

and click OK. 

 

Add Shading 

To add shading to a table, select the rows or columns you want to add 

shading to and click the arrow to the side of the Shading icon.  If you 

hover over the colours to view the changes, click to apply the colour. 

 

 



 

 

Alternatively, select the table and right click and select Borders and Shading from the 

menu options.  Click the Shading tab and adjust the settings as required.  Check the 

Preview area and the Apply to box and click OK. 
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